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CONTACT 
INFORMATION 

Textbook Services Office 

Kari Carpenter   
Project Coordinator   

515-964-6636 
k3000a@dmacc.edu 

2006 S. Ankeny Blvd, 
Building 6, Room 20E 

Ankeny, IA 50023 

Disability Services Office 

Jennifer Argo 
Disability Services Coordinator 

515-964-6850 
jdargo@dmacc.edu 

2006 S. Ankeny Blvd, 
Building 6, Room 10B 

Ankeny, IA 50023 

The Textbook Services Department supports all DMACC students granted the 
accommodation of an alternate format for their textbooks. To locate the contact for 
your home campus, please call 515-964-6636 or 515-964-6850. 

mailto:k3000a@dmacc.edu
mailto:K3000a@dmacc.edu
mailto:K3000a@dmacc.edu
mailto:jdargo@dmacc.edu
mailto:jdargo@dmacc.edu
mailto:jdargo@dmacc.edu
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WHAT IS KURZWEIL 3000 
Kurzweil 3000 is an integrated scan and read software program that provides multisensory access to 
reading material as well as tools for reading, writing, test-taking and learning. Kurzweil 3000 is a 
technology tool that provides a digital environment for implementing proven learning strategies and 
accessing the general education curriculum. Kurzweil 3000 is designed in accordance with the principles 
of Universal Design for Learning, providing multiple means of representation, expression and 
engagement in an effort to support all students with tools that are necessary for some, but beneficial for 
all. 

Kurzweil 3000 helps learners overcome challenges of all kinds, at any age, and on any device by the 
following: 

• Boosting Reading Fluency 
o Reads text aloud, highlighting words and sentences as they’re spoken to help students follow 

along. 
o Natural Text-to-Speech voices in 13 languages and 18 additional dialects. 
o Customizable reading rate and presentation. 
o Improve readability with OpenDyslexic font, text magnification (installed desktop only) and 

zoom. 
o ABBYY FineReader OCR creates the highest accuracy in character recognition for reading 

aloud. 
o Customizable background and text color. 

• Increasing Comprehension 
o Engages Learners with 5 different note tools including Sticky, Bubble and Voice Notes. 
o Highlight key text with multiple colored highlighters which can be extracted into study notes. 
o Create vocabulary study guides with automatically generated word definitions. 
o Extract notes and highlighting into a Column Notes study guide. 
o Embedded read-aloud American Heritage Fifth Edition Children’s and College Writers 

Dictionaries and Widget Picture Dictionary as well as synonym and translation reference tools. 
• Assisting Writing and Assignments 

o Start writing with over 50 template guides. 
o Highlight text on the web or within a document and extract into study notes. 
o Visually organize and map notes and ideas with Brainstorm and Graphic Organizers. 
o View outlines and drafts simultaneously with Split Screen. 
o Ease the writing process with dictation using Speech-to-text (Kurzweil3000.com on chrome 

browsers only). 
o Word prediction offers word suggestions based on word frequency. 
o Expand word choices with the Synonym tool. 
o Save file to Google Drive and OneDrive. 

• Improving Test Taking.  
o Tests can be created to be read aloud with student’s preferred voice and speed. 
o Read the Web for Respondus Lockdown browser for reading online tests. 

https://Kurzweil3000.com
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COSTS ASSOCIATED WITH 
KURZWEIL 3000 

For a student who is currently enrolled at DMACC and has been granted 
accommodations for textbook services, there is no cost for the 
use of Kurzweil 3000. Other than the student’s personal computer or 
electronic device, DMACC takes responsibility for any fees associated 
with this use. Once a student is no longer enrolled at DMACC, access 
to Kurzweil 3000 will be removed. 

Any student who is currently enrolled at DMACC and wishes to 
purchase a single license for their own personal use, may do so directly 
from Cambium Learning at a student discounted price. Please contact 
Cambium Learning for more information: 

Phone (Toll Free): 1-800-894-5374 

Internet: www.kurzweiledu.com 

E-mail: customerservice@kurzweiledu.com or sales@cambimtech.com 

Mail: Kurzweil Education   
24 Prime Park Way 
Natick, MA 01762 

http://www.kurzweiledu.com/
mailto:customerservice@kurzweiledu.com
mailto:sales@cambimtech.com
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FREQUENTLY ASKED QUESTIONS 
1. How do I apply for textbook services? 

Click the “How to Apply for Accommodations” tab on the Disability 
Services page of the DMACC website for application information. 

2. After my accommodations are granted, what is the procedure to obtain 
my textbooks on Kurzweil 3000? 

Please contact the Textbook Services Office at k3000a@dmacc.edu or 
(515)964-6636 for instructions. 

3. How long will I have to wait to receive my textbooks on Kurzweil 3000? 

Depending on the circumstances, it may take up to two weeks before the 
first few chapters are available. The sooner we receive your request, the 
sooner we can begin the process. It is important to provide us with the class 
reading schedule if the instructor is using the textbook out of sequence. 

4. How will I know when chapters are available in Kurzweil 3000? 

An email will be sent to your DMACC address when the first chapters are 
ready. After the original email, you will need to check your Kurzweil library 
regularly for new chapters. 

5. How do I access my textbooks in Kurzweil 3000? 

Information is provided beginning on page 11 for Window users, page 17 
for Macintosh users and page 23 for Web users. 

6. Can I have class handouts scanned into Kurzweil? 

Yes. You may drop the handouts off in our office (Bldg. 6 Rm 20E) or email 
them to us at k3000a@dmacc.edu. Please allow a 24-hour turn-around time. 

CONTINUED… 

mailto:k3000a@dmacc.edu
mailto:k3000a@dmacc.edu
mailto:k3000a@dmacc.edu
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7. Can I save my books/chapters to my computer? 

Yes. You can save books/chapters to your computer, a flash drive, or to your 
Kurzweil library (recommended). Saving content to your Kurzweil library 
will allow you to access that content from any computer with internet access. 

8. What is Kurzweil 3000 for Web Browser? 

Kurzweil 3000 for web browser allows you can access content on any device 
or computer with internet access. You will use the same username and 
password provided regardless of how you choose to access content. 

9. Why are my chapter numbers out of order in my Kurzweil Library? 

Kurzweil uses the first number of a chapter when creating the order 
sequence. For example, 1, 11, 12, 13, etc. will all be listed together. Then 
2, 20, 21, 22, etc. followed by 3, 30, 31, 32, etc. 

10. Is it possible to read the web with Kurzweil 3000? 

Yes. The Kurzweil 3000 Read the Web feature allows you to use its reading 
and reference tools with content in a Web browser. You have the option of 
using the Google Chrome or Mozilla Firefox web browser. Please see 
instructions beginning on page 31. 

12. How do I schedule a test reader? 

Please see page 43 for instructions on scheduling a test reader. 

13. Can I have a reader for my online class in Canvas? 

Yes.  Canvas has a built-in text-to-speech reader called ReadSpeaker that can be 
used for studying and taking tests and quizzes.  See page 39 for more information. 

14. Who do I contact if I am having problems or have questions? 

Please contact DMACC Textbook Services at k3000a@dmacc.edu or at 
(515) 964-6636. If you are having technical issues with Kurzweil after 
Textbook Services hours, you may contact Kurzweil’s tech support at 1-800- 
894-5374 or at tech@kurzweiledu.com. 

mailto:k3000a@dmacc.edu
mailto:tech@kurzweiledu.com
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Kurzweil 3000   
for Windows Download 

Getting Started 
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Open Kurzweil 3000 

Double Click the Kurzweil 3000 icon on your desktop. 

Login (Web License Subscription Only): 
Your username and password is the same for ALL Kurzweil 3000 Subscription components. 
If you are the Kurzweil site administrator – login is emailed to you in your welcome package from 
Kurzweil’s Customer Service team. 
If you are a teacher or student – check with your school/district Kurzweil site administrator to 
obtain your username and password. 

The Kurzweil 3000 Home Tab 
From here you can: 

• Open a file from the Universal Library, your local computer or Google docs 
• Start a new draft document 
• Start a new brainstorm document 
• Start a new outline 
• Scan a new file 
• See the Tip of the Day 
• See a list of the most recent opened doc 

Other Quick Access Tabs 
Read – starting point for reading and highlighting a document 
Write – starting point for the writing path 
Scan – starting point for scanning 

Read buttons and Options dropdowns (Audio, Reference, Online) will be constant on all tabs 

Toolbars and Ribbon 

Each tab has its own toolbar and ribbon across the top 
and toolbar down the left side. 
The tools will change depending on the tab you are in. 

Use the View menu to toggle the toolbars and ribbon on and off. The 
next time you login, the settings will be remembered. 
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Access Content 

Kurzweil 3000 can open a variety of files and convert them to .kes files. 

From your local Computer, the Universal Library, or Google Drive 
• From the Kurzweil 3000 tab choose Open Existing File 

The Universal Library (Web License Subscription Only) 
Unlimited cloud storage for your Kurzweil 3000 files in addition to some pre-loaded content: 

• Your Private and Public folders 
• Public folders for the Top Level admin and any teachers or 

studentsin your team. Students cannot see other student’s 
folders. 

• Classic Literature folder (1800+ titles) 
• Help files folder 
• Non-Fiction Bookbag folder containing 15 titles for grades 3 through8 
• Sample files folder 
• Templates 

Click on your name to select, and click the plus (+) 
button Click on the folder where the file is saved 
Choose the file from the list on the right 

From Google Drive 
• You will be asked to sign in to Google Drive via the web 
• Return to K3000 - the Open from Google Drive folder will be displayed, click on My Drive to see files 

Bookstores/Online 
You cannot import a Kindle eBook, but can import eBooks from other 
sources Download the book as an ePub or PDF file to your computer 

Images of Printed Material - pictures of pages, articles taken with cell phone, iPad, etc. 
• Save (or upload) image to Google Drive or your localcomputer 
• Open the image using the appropriate button listed above 

From Online File Storage - such as Dropbox, OneDrive, Box, etc. 
• Download the file to your computer from the online storage program (such asDropbox) 
• Use the Open from Local Computer button or the File menu > Open, to locate thefile 

From a Scanner (connected to your computer) 
• Choose the Scan tab, choose Scanner Setup button to the right of 

the Zoom options and choose your scanner 
• Place the document or page on the scanner, click the Start a Scanbutton 

Virtual Print – bring files from another application into K3000 to save as a .kes file 
• Open a file in its native application. File > Print and choose the KESI Virtual Printer. 
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You’ve Opened it, Now Read it! 

Feature Steps 
Read Text Aloud or Silent Place your cursor in the text and click the 

Read button (F3) to start reading. 
The Forward and Backward buttons will skip 
to the previous or next reading unit. 
The Audible Reading button toggles between 
audible and silent reading. 

Read button 

Change the Speaking Voice 

NOTE: For English Language 
Learners and for reading text in 
foreign languages: 
23 voices and 10 languages 
supported! 

• Click the Audio Options dropdown 
• Choose a speaker from the dropdown list 

Kurzweil will access any speech engines on your 
computer. The install includes 20+ High Quality 
voices from Acapela! 

Audio Options dropdown 

Change the Reading Speed 
(Words per Minute) 

• Click Audio Options dropdown 
• Change the WPM (words per minute) 

setting up or down 
Increase: (F11) Decrease: (F12) 

Audio Options dropdown 

Change size of Text 
Increase or decrease the size 
of an image document by 
changing the Zoom value. 

• Click the Plus or Minus buttons onyour 
Zoom button 

• OR Click the down arrow to selecta 
preset zoom value. 
Zoom in: (F7) Zoom out: (F8) 

Zoom button 

Change the Reading Mode • Continuous: continuous reading from 
page to page. 

• Self-Paced: pause at the end of each unit. 
• Word by Word: pause at the end of each 

word 
• Click Read button to begin again. 

Audio Options dropdown 

Change the Reading Unit • Click on Reading Unit button and choose 
the block of text that is highlighted when 
reading. 

Audio Options dropdown 

Change the Page • Click the green LEFT and RIGHT arrowson 
your Page buttons. 
OR 

• Click the box and type the page number 
• Press Return/Enter on your keyboard 

Page buttons 

Next Page (Ctrl E) 
Previous Page (Ctrl R) 
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Basic Vocabulary Tools 
Feature Steps 
Get Definition of a Word • Place your cursor just before a wordor 

double click on a word to select it 
• Click on the Definition button 

Read or Write toolbar: 
Dictionary (Ctrl D) 

Find Synonyms of a Word to 
support comprehension or to 
expand word-choices when 
writing. A Digital Roget’s 
Thesaurus is built in to 
Kurzweil 3000. 

• Place your cursor just before a wordor 
double click on a word to select it 

• Go to the Reference dropdown and 
choose Synonym 

Reference dropdown: Synonym (Ctrl Q) 

Translate passages of text to • Highlight the selection of text youwould 
like translated. 

• In the Online dropdown, click the 
Translate button 

• Select the Language From andLanguage 
To 

• Click Translate 
• Click Read to hear the text 
• OR Click Open in new document tocreate 

a new document of the translation. 
• Save the new document. 

Online dropdown: Translate 

* 64 Languages supported 
A powerful tool for English Language 
Learners to translate on the fly and build 
their knowledge of English. 

another language (powered by 
Google Translate). 

NOTE: Also great for translating 
documents to share non-legal 
documents with students, 
parents and other members of 
the team. 
NOTE: You must be connected 
to the internet to use this 
feature. 
Get a Picture of a word using 
the built-in picture dictionary 
including 12,000 Widgit 
Symbols 

• Place your cursor just before a wordor 
double click on a word to select it 

• Click on the Picture button 
• Picture will pop up 

Read or Write toolbar: Get picture of 
selected word 

Basic Study Tools 
Feature Steps 
Highlight, Circle or Cross out 
text 

• Different colors of highlighters let you 
associate different concepts with 
different colors 

• Choose a highlighter, click and drag 
across text to highlight, circle or crossout 

Read or Write toolbars: Highlighter 

Erase Highlights or Circles Highlights and Circles can be erased by 
selecting the Erase tool and dragging your 
mouse over the highlighted or circled text. 

Read or Write toolbars: Highlight Eraser 

Extract Highlights to an 
outline 

Highlights can be extracted to an outline. 
In the dialog box you can customize the 
extraction settings. 

File > Extract > Extract Notes and 
Highlights… 
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Basic Study Tools 
Feature Steps 
Insert a Sticky Note Sticky Notes can be used to insert 

questions/notes about the text or provide 
instructions. They are brightly colored and 
standout when reading the text. 
• Click on the Sticky Note button 
• Click anywhere on your open document 
• Begin Typing 

Read or Write toolbar: Sticky Note 

NOTE: not available in text documents 

Insert a Text Note Text Notes can be used to answer questions 
in a .kes test or quiz file. They have a 
transparent background – great for fill-in-the- 
blanks or labeling graphics. 
• Click on the Text Note button 
• Click anywhere on your open document 
• Begin Typing 

Read or Write toolbar: Text Note 

NOTE: not available in text documents 

To quickly insert text notes on every 
blank line on a page: 
Tools > Fill-in-the-blanks 

Insert a Voice Note 
Voice notes are a great way to 
support English Language 
Learners by embedding 
clarifying notes recorded by 
native speakers of the language. 

Voice note tool can be used to insert a 
recording of your own voice. 
• Click on the Voice Note button 
• Click anywhere on your open document 
• A dialog box will open 
• Click on the microphone to recorda 

message up to 120 seconds long. 
• Click OK 
• To hear the note: Double click 

Study skills toolbar: Voice button 

NOTE: Microphone is needed to record 
voice notes. 

Delete a note • Click on the note ONE time 
• Click Delete button 

OR 
• Right Click on a note and selectDelete 

note 

Read toolbar: Delete 

Insert a Bookmark to mark 
important places in the text. 

• Click anywhere on your open file. 
• Click on the Bookmark button 
• Type in a description and click Add 
• To view Bookmarks in a document, click 

on the bookmark tool to view them all. 
• Click on the Bookmark you would liketo 

Go To. 

Bookmark button 
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Kurzweil 3000   
for Macintosh Download 

Getting Started 
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Open Kurzweil 3000 

Double Click the Kurzweil 3000 icon on your desktop, 
dock or Applications folder. 

Login (Web License Subscription Only): 
Your username and password is the same for ALL Kurzweil 3000 
Subscription components. 
If you are the Kurzweil site administrator – login is emailed to you in your welcome package from Kurzweil’s Customer Service team. 
If you are a teacher or student – check with your school/district Kurzweil site administrator to obtain your username and password. 

The Tip of the Day will automatically open with a 
different tip. You can click Previous, Next or Random to 
see other tips. 

Starting Points 
From here you can: 

• Open a New draft document 
• Open an existing file from your local 

computer 
• Scan a document 
• Read the Web (Subscription licensesonly) 

Kurzweil 3000 Reader 
Start reading and customize your reading 
settings 

Toolbars and Palettes 
Different toolbars and palettes will be available based on the type of document you are in. 
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Access Content 

Kurzweil 3000 can open a variety of files and convert them to .kes files. 

From your local Computer, the Universal Library, or Google Drive 
• File > Open…, Open from Universal Library, or Open from GoogleDrive 

The Universal Library (Web License Subscription Only) 
Unlimited cloud storage for your Kurzweil 3000 files in addition to some pre-loaded content: 

• Your Private and Public folders 
• Public folders for the Top-Level admin and any teachers or 

studentsin your team. Students cannot see other student’s 
folders. 

• Classic Literature folder (1800+ titles) 
• Help files folder 
• Non-Fiction Bookbag folder containing 15 titles for grades 3 through8 
• Sample files folder 
• Templates 

Click on the toggle arrow next to a folder to 
expand it Click on the folder where the file is 
saved 
Choose the file from the list on the right 

From Google Drive 
• File > Open from Google Drive 
• Click the Sign In button if you are not already signed into GoogleDrive 
• Locate your file and click Open 

Images of Printed Material - pictures of pages, articles taken with cell phone, iPad, etc. 
• Save (or upload) image to Google Drive or your localcomputer 
• Open the image using File > Open… or Open from GoogleDrive 

From Online File Storage - such as Dropbox, OneDrive, Box, etc. 
• Download the file to your computer from the online storage program (such asDropbox) 
• Use File > Open, to locate the file 

From a Scanner (connected to your computer) 
• Choose Scan > Scan New Document 

Virtual Print – bring files from another application into KURZWEIL 3000 to save as a .kes file 
• Open a file in its native application 
• File > Print 
• In the PDF dropdown, choose Open as a PDF in Kurzweil3000 
• The file will appear in KURZWEIL 3000 to be read, saved, etc. 
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You’ve Opened it, Now Read it! 
Feature Steps 
Read Text Make sure the Kurzweil 3000 Reader is 

showing Window > Show Reader 
Place your cursor in the text and click the 
Read button (R) to start reading. 
The Forward and Backward buttons will skip 
to the previous or next Reading Unit. 

Reading Unit The block of text that is highlighted when 
reading. 

• Word 
• Phrase 
• Line 
• Sentence 

• Highlights Only (the text you have marked 
with a highlighter tool) 

Reading Mode • Continuous: continuous reading from unit 
to unit and page to page. 

• Self Paced: pause at the end of each unit. 
• Word by Word: pause at the end of each 

word 

Reading Voice Kurzweil 3000 installs with several Acapela 
Voices and includes an Additional Acapela 
Voices Install for foreign languages. 

Turn off speech, but continue 
to highlight words to keep on 
task. 

To turn off speech and practice silent reading 
or oral reading fluency skills with Kurzweil 
3000: 
• Select Read Silently 

Reading Speed The Reading Speed WPM can be increased or 
decreased to support the needs of the user 
and the density of the text being read. 
• Click the UP or DOWN arrows on your 

Words per Minute button. 
• OR Click in the box on your Speed button 

and type the desired WPM 

Change size of text To support users with low vision, you can 
easily increase or decrease the size of a 
document viewed in Kurzweil 3000 by 
changing the Zoom value: 

• At the bottom of the documentuse 
the slider to change text size 
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Basic Vocabulary tools 
Feature Steps 
Get Definition of a word • Place your cursor just before a wordor 

double click on a word to select it 
• Click on the Word Lookup button in the 

Kurzweil 3000 Reader 
• Select Definition 
• Click the Read button on Kurzweil 3000 

Reader to read definitions aloud 

Find Synonyms of a word A Digital Roget’s Thesaurus and Concise 
Oxford Thesaurus are built in to Kurzweil 
3000: 
• Select a word and click word lookup 
• From the Word Look Up window selectthe 

Synonyms button 
• Click the Read button on the Kurzweil 

3000 Reader to hear the synonyms 
Translate text 
Kurzweil 3000 uses Google 
Translate 

NOTE: You must be connected 
to the internet to use this 
feature. 

• Select Text you would like to translate 
• Online > Translate 
• Select Language From/To 
• Click Translate 
• Click Read 
• 70+ Languages supported 

Get a Picture of a word 

Built-in picture dictionary 
using 12,000 Widgit Symbols 

• Place your cursor just before a wordor 
double click on a word to select it 

• From the Word Look Up window selectthe 
Picture button 

Basic Study Tools 
Feature Steps 
Highlight, Circle or Cross-out 
text 

• Different colors of highlighters let you 
associate different concepts with 
different colors 

• Choose a highlighter, click and drag 
across text to highlight, circle or crossout 

Erase Highlights or Circles Highlights and Circles can be erased by 
selecting the Erase tool and dragging your 
mouse over the highlighted or circled text. 
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Feature Steps 
Extract Highlights to an outline Highlights can be extracted to an outline. 

In the dialog box you can customize the 
extraction settings. 

File > Extract > Extract Notes and 
Highlights… 

Insert a Sticky Note Sticky Notes can be used to insert 
questions/notes about the text or provide 
instructions. They are brightly colored and 
standout when reading the text. 
• Click on the Sticky Note button 
• Click anywhere on your open document 
• Begin Typing 

NOTE: not available in text documents 

Insert a Text Note Text Notes can be used to answer questions 
in a .kes test or quiz file. 
• Click on the Text Note button 
• Click anywhere on your open document 
• Begin Typing 

NOTE: not available in text documents 

Insert a Voice Note 
Voice notes are a great way to 
support English Language 
Learners by embedding 
clarifying notes recorded by 
native speakers of the language. 

Voice note tool can be used to insert a 
recording of your own voice. 
• Click on the Voice Note button 
• Click anywhere on your open document 
• Click the Record button to record a 

message up to 120 seconds long. 
• To hear the note: Double click 

NOTE: Microphone is needed to record 
voice notes. 

Insert a Bookmark to mark 
important places in the text. 

• View > Bookmarks to open the 
Bookmarks pane. 

• Place your cursor in your file. 
• Click on the Bookmark button 
• In the Bookmarks pane, type the nameof 

your bookmark and hit Enter. 
• To go to a specific bookmark,double-click 

it in the list 
Delete a note or bookmark • Click Erase button 

• Click on the icon in the text for thenote 
you want to erase. 

Basic Writing tools   
Feature Steps 
Start Writing • Click New button on Starting Points 

• Or File > New 
• A new Blank Document will open with 

writing tools displayed in the document 
toolbar 

• Begin typing 
Listen to my written work Using Kurzweil 3000’s talking word processor 

to read text out loud can be extremely helpful 
with editing and revising written work. 
• Place your cursor at the beginning of text 

you would like to read 
• Click the Read button 
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Kurzweil 3000 
for Web Browsers 
GettingStarted 
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The Universal Library 
Go to https://www.kurzweil3000.com and login to your account 

Or click the Login link on our web 
page: 
https://www.kurzweiledu.com 

Home - The Universal Library (UL) 

This is the same library you see in Kurzweil 3000. 

Individual Account Folders 
Current user – first account in the list (yellow). 

• Teachers will see and have access to the Public and Private folders of members of theirTeam. 
(See the User Management section to learn about adding members to your team.) 

• Students will see the Public folder of their team leader. Students cannot see other student’s folders. 
• Everyone sees the Public folder of the Top Level Account – second account in the list(red). 

General Folders: 
• Main Subscription Account (red) – everyone has access to the Public folder of the main subscription. 
• Classic Literature - over 1800 titles 
• Help Files - support documents and guides to Classic Literature and NonfictionBookbag 
• Nonfiction Bookbag - nonfiction book titles for grade levels 3-8 
• Samples - sample files from Language Program, Passport Reading Journeys, and ReadingA-Z 
• Templates - Brainstorm templates for both teachers and students 

Open a folder by clicking on the folder’s name. 
The panel to the right will display the files within that folder. 

File Management 
You can manage files in the UL similarly to your local computer. 

• Right click on a folder to Add a sub-folder, Delete orRename. 
• Click the check box next to a file name and use the buttons to Copy, Copy to Multiple (teacher only), Move, 

Delete or Rename. 
• Click and drag a file or folder to Move it. 
• Hold the CTRL key (Windows) or the Command key (Mac) while dragging a file or folder to copy it. 

Copying or moving a file on its own or within a folder will retain any annotations within the file (highlights, 
bookmarks, bubble, sticky and text notes.) 

http://www.kurzweil3000.com/
http://www.kurzweiledu.com/
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Access Content 

Kurzweil 3000 can open a variety of files and convert them to 
.kes files. Supported file types: 

• Daisy • EPUB 
• TXT • BKS 
• DOC • PDF 
• DOCX • JPG and JPEG 
• RTF • PNG 

The Universal Library 
• Select a file within a folder 

Your Local Computer 
• Click the Computer button and choose the file you would like to open 
• Click the Upload button to copy a file to your Universal Library but not open it. 

Google Drive 
• When you click the Google Drive button you will be asked to login in to Google Drive if not already logged in 
• Choose the file and click Select 

Bookshare.org 
You can import books directly from Bookshare.org (an account is required) 

• Click the Bookshare button and search by author, title or ISBN 

Bookstores/Online 
You cannot import a Kindle eBook, but can import eBooks from other sources 

• Download the book as an ePub or PDF file to yourcomputer 

Images of Printed Material - pictures of pages, articles taken with cell phone, iPad, etc. 
• Save (or upload) image to Google Drive or your localcomputer 
• Open the image using the appropriate button listed above 

From Online File Storage - such as Dropbox, OneDrive, Box, etc. 
• Download the file to your computer from the online storage program (such asDropbox) 

Once you’ve opened a file, various menus and buttons are available across the top and left side of the 
screen. (Hover the mouse over a menu or button to display the tool tip.) 

https://Bookshare.org
https://Bookshare.org


22 

You’ve Opened it, Now Read it! 

Read Text Aloud or Silently 
• Place your cursor in the text and click the Read button to startreading. 
• The Forward and Backward buttons will skip to the previous or next reading unit. 
• The Audible Reading button toggles between audible and silentreading. 

Navigation shortcut keys 
Chrome Edge Firefox Internet Explorer Safari 

Zoom In + + CTRL + + + 
Zoom Out - - CTRL - - - 
Play/Pause P P P P P 
Go Back* V V V V V 
Go Forward* N N N N N 
*Image files only 

Audio Options 
Customize and personalize the reading experience. 

Voice 
Choose from many different voices and languages. 

Reading speed 
Adjust the speed Faster or Slower. 

Multi-Language Voice Preferences 
Set the defaults for multiple language 
voices (See Language Learning section). 

Unit 
The block of text that is highlighted when 
reading. Choose between word, line, sentence, 
or paragraph. 

Mode 
• Continuous: continuous reading from page to page. 
• Self-Paced: pause reading at the end of each unit. 
• Word by Word: pause reading at the end of eachword. 
• Click the Read button to continue Self-Paced and Word byWord. 

Skip Reading Headers/Footers 
• Header/footer zones will not be read when this option is checked. 

Speak as Typing (can have multiple options selected) 
• All Characters: reads each character as you type it. 
• Whole Words: reads each word as you complete it by typing a space afterit. 
• Whole Sentences: reads each sentence as you complete it by typing final punctuation afterit. 

Change the Page 
• The status bar at the bottom of the image tells you what pageyou 

are on. Type in the Go to Page field and click GO to jump to a specific page. 
Use the Previous and Next arrows to the left and right of the image to change pages. 
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Document View and Zoom 
• View thumbnails of each page of your document. (Image file 

only) Click a thumbnail to go to that page. (Image file only) 
• Uncheck Fit Width to zoom in or out. (Image fileonly) 
• Change the Document Zoom magnification of the 

page. (Image file only) 
• Rotate or Flip the page. (Image file only) 
• Customize the Background Color of an image or textdocument. 
• Note: This color is only for viewing the 

document. It will print with a white 
background. 

• Choose a Download Format to save the document as another 
type of file. 

• Show Bookmarks and Bubble Notes in the 
document. (Image file only) 

• Print Page 
• Set Document Password 

DON’T FORGET YOUR PASSWORD! 
There are no hints and it cannot be reset or changed if you forget! 

Basic Vocabulary Tools 
References drop down 
menu Dictionary 

• Place cursor before a word 
• References menu > Dictionary button. 
• Choose a dictionary from the dropdown. 

Picture Dictionary 
• Place cursor before a word 
• References menu > Picture Dictionary button. 

Synonyms 
• Select a word or phrase in thetext 
• References menu > Synonyms button. 

Translation (powered by Google Translate) 
• Select a word or phrase in the text 
• References menu > Translation button. 
• A readable dialog box will pop up allowing you to select the 

desired language for detection and translation. 
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Basic Study Tools 

Bookmarks 
Add a bookmark or go to a specific bookmark in the document 

• Click in the text where you want to place thebookmark 
• Click the Bookmark button 
• Use Description to add a bookmark 
• Choose a bookmark in the list to Go To that place in the document orDelete 

a bookmark. 

Highlight, Circle or Cross out text 

Any highlights you add within the web app will also be visible when you open the 
document in Kurzweil 3000 for Windows or Mac. 

• Different concepts can be marked with different color highlights 
• Choose a highlighter, click and drag across text to highlight, circle or crossout. 
• Hit the Esc key to return to Select mode. 
• Extract your highlights to an outline. 
• Customize the highlighter names and extraction settings. 

Document Notes menu 
Add, select or delete Bubble, Sticky and Text notes in your documents. 

• Choose to show only one or both types of notes. 
• Options for Font, Font Size, Styling, and Color of Sticky or TextNotes. 

Add 
• Click Add Bubble Note, Add Text Note or Add StickyNote. 
• Click on the screen to add the note. 

Move 
• Click and drag the top or left side of the note to moveit. 

Resize (Sticky and Text notes only) 
• Hold the mouse button down on the lower right corner anddrag. 
• Hit the Esc key to return to Select mode. 
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The Writing Path. The writing path can be used to help students write papers 
by offering options for brainstorming, outlines, drafts and column notes.   

In addition to editing existing DOC, DOCX, RTF, TXT and some KES documents, you can create new documents 
using the Write menu options and text editor features.   

The Writing Path consists of an integrated set of tools that support and correlate with the stages of the writing 
process. 

Starting points for writing.   

There are several starting points for Writing using Kurzweil 3000 in your Web Browser. You can start a New 
Brainstorm, Outline, Draft, and Column Notes File by choosing from the Write menu. 

  

All three parts of the Writing Path (Brainstorm, Outline, and Draft) are views of a single text document. This 
means you can:   
• Go back and forth between the Brainstorm and Outline views. 
• Because Brainstorm and Outline share the same information, each view preserves the content and 
organization from the other view, while presenting the information in a different format. Changes in one view 
are reflected in the other view.   
• Go from Outline to Draft. You can create a Draft from an existing outline.   
• Outline and Draft can be viewed in split screen mode.   

Use the Starting Points table below to determine the best starting point for your writing style. 
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Starting Point for 
Writing. 

Description. Switching Views. 

Choose New Brainstorm from 
the Write menu. 

Brainstorm is a graphic organizer 
that lets you visually organize 
your thoughts and create a 
"diagram" or graphic plan for 
your writing. 

Opens a new Brainstorm, 
graphic organizer file. 

This is a good starting point if 
you like to visualize your 
thoughts. 

You can use the Brainstorm 
tools to quickly get your 
thoughts out and just as quickly 
organize them. 

Click Outline view and you have 
an outline ready to use or 
submit to your instructor. You 
can even work in both views, 
switching back and forth. 

Brainstorm From Template. 

Kurzweil 3000 for the Browser 
includes several templates in the 
Universal Library. The templates 
contain instructions and 
organization in graphic format. 

Choose a template and copy to a 
folder that you have write access to. 

Opening the copied template is 
a good starting point if you 
require guidance as you 
compose your piece, and you 
like to visualize your thoughts. 

You can use the Brainstorm 
tools to edit and reorganize 
your thoughts. 

Click Outline view and you have 
an outline ready to use or 
submit to your instructor. You 
can even work in both views, 
switching back and forth. 

Choose New Outline from the 
Write menu. 

Outline lets you jot down and 
organize your thoughts into a 
text-based, hierarchical writing 
plan. 

Opens a new Outline file. 

Use this as a starting point if 
you like to use text-based 
organization for your thoughts. 

You can use the tools to move 
Topics around and restructure 
the outline as you work. 

Click Brainstorm view if you 
want to see your outline in 
graphic format. You can work in 
both views, switching back and 
forth. 

Draft from Outline. 

Opening a draft from the Outline 
tool opens the draft including the 
outline. 

Opens a draft window including 
the outline so you can expand 
your outline with explanatory 
text. 

If you start here, you can switch 
to Brainstorm and Outline 
mode. 

Choose New Draft from the 
Write menu. 

Draft is where you go through 
iterations of your document, 
writing, revising and editing. 

Opens a new/empty .kes text 
file. If you like to write in free- 
form or stream-of- 
consciousness style, this may 
be a good place to start. 

To organize/re-organize, use 
Copy/Cut/Paste. 

If you start here, your draft is 
not connected to the 
Brainstorm and Outline modes. 

**Additional information on writing is available upon request at k3000a.dmacc.edu or at kurzweiledu.com under the Academy tab. 

https://kurzweiledu.com
https://k3000a.dmacc.edu
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Kurzweil 3000 Read the Web Extension for Chrome and Firefox 

Set up the Read the Web extension for Chrome 
If you use Chrome as your default web browser, Kurzweil has both an app and an 
extension. Use the Kurzweil 3000 Chrome app to quickly access the web app login 
page. 
Use the Kurzweil Read the Web extension to add a reading toolbar and reading options to your browser. 

• Launch Chrome 
• Go to the Chrome App Store and search for “Kurzweil” or“K3000” 

Click Add to Chrome for both the Kurzweil 3000 app and the Read the Web extension. 
(Note: Kurzweil 3000 does not need to be installed on the computer. Only your login is required.) 

The Kurzweil 3000 Chrome app will be added to your 
Apps page. Click it to go directly to the Kurzweil 3000 
Web App login page https://www.kurzweil3000.com 
The Kurzweil 3000 Web app is covered in more detail in the 
Web App section. 

The Kurzweil Read the Web extension will add the Kurzweil icon to the   
upper right corner of Chrome. 

Set up Mozilla Firefox to Read the Web 

The Read the Web toolbar can be installed into the Firefox browser. 

Go to https://www.kurzweiledu.com, choose Products at the top right, Software Updates, scroll down to Other Tools 
and choose your version. 
Follow on-screen directions to install. 
In Firefox there will be a Kurzweil icon in the upper right of the browser bar 

http://www.kurzweil3000.com/
http://www.kurzweiledu.com/
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Using Chrome or Mozilla Firefox to Read the Web 

When you browse to a page with readable text, click the icon and login using your Kurzweil 3000 username and 
password. 

Reading, dictionary, and translation buttons are available to use on any web page. 

Click the Options button for all of the same reading options you use in Kurzweil 3000, the web app and the 
iPad app, as well as the changing the position of the mini toolbar. 
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Kurzweil 3000 Taskbar/Screenshot Reader 
for Windows 

**The Kurzweil 3000 taskbar/screenshot reader can be useful for reading things such as a small section   
of the internet, an online test, or a locked/secured PDF.  It is for the Windows download version only. 

The Kurzweil 3000 Taskbar, which appears as a small bar in the Windows 
Taskbar, provides quick access to a subset of Kurzweil 3000 features: Read, 
Dictionary Look Up, and Check Spelling. 

This is convenient when you are working in applications other than Kurzweil and want 
to quickly read a short selection of text, check your spelling or look up the 
definition of a word. This feature can be helpful when needing to read an online 
test. You can drag selectable text from any application and “drop” it onto the 
Kurzweil 3000 taskbar. 

Using the Taskbar: 
• First, make sure the Kurzweil Taskbar is visible. If it isn’t: 

1. Right Click on your Taskbar 
2. Select “Toolbars” 

3. Select “Kurzweil Taskbar” 
4. Let go of your mouse 
5. You should see the Kurzweil 

icons in your taskbar 
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Using the Taskbar Reader: 
1. From within any application (email, webpage, blog, etc. anything 
with selectable text) highlight the text you would like to read and drop 
it into the Kurzweil 3000 box in your taskbar. You can either click and 
drag the text orcopy and paste. 

2. A separate dialog box will open and your text will be read to you. 
(You may need to click the green “Read” button.) 

3. To change the settings for the Taskbar, click on thegear 
the dialog box. 

Using the Screenshot 
Reader: 

on the bottom of 

Click on the Screenshot Reader in the Taskbar. Crosshairs (+) will appear. Use 
those to draw a box around the text you want read to you. Kurzweil will pull the 
text out into a separate box and read it aloud. Close that window then repeat steps 
to continue reading through the text. 

        OR 
         

After logging in to Kurzweil 3000: 
  

• Open the screenshot that you want to read (a web page, forexample). 
• Choose Screenshot Reader from the Kurzweil 3000 Read menu.The Kurzweil window 

closes and the cursor changes tocrosshairs. 
• Use the crosshairs to select any text, including content that is not usually selectable. Move the 

crosshair to the top left corner of the area you want to select. Hold down the left mouse button 
and draw a rectangle around the selection. 

• Release the mouse button when you reach the bottom right of the selected area.   
• The Kurzweil window reopens and displays the text for you to read. 
• Click the Read button to read the text.   
• When you are finished,you can Close the text or Save it. 
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Kurzweil 3000 Taskbar/Screenshot Reader   
for Macintosh 

**The taskbar/screenshot reader can be useful for reading things such as a   
Small section of the Internet, an online test, or a locked/secured PDF. It is for the Mac   
download version only. 

The Screenshot Reader is a tool that lets you select an image that you want 
to read. To select an image: 

1. Open the screenshot that you want to read (a web page, forexample). 
2. Choose Screenshot Reader from the Kurzweil 3000 Read menu.The Kurzweil 

window closes and the cursor changes tocrosshairs. 
3. Use the crosshairs to select any text, including content that is not usually 

selectable. Move the crosshair to the top left corner of the area you want to select. 
Hold down the left mouse button and draw a rectangle around the selection. 

4. Release the mouse button when you reach the bottom right of the selected area. 
The Kurzweil window reopens and displays the text for you to read. 

5. Click the Read button to read the text. When you are finished,you can Close the 
text or Save it. 
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SQ3R Strategies with Kurzweil 3000 

**These reading strategies may be helpful for students 
looking for additional study tips. 

SQ3R 
Survey, Question, Read, Recite, Review 
Active reading requires thinking about text, activating background knowledge, making 
connections, taking notes, reviewing notes, rereading text and testing your newly acquired 
knowledge. SQ3R is a proven systematic strategy for actively reading text with a goal for 
improved reading comprehension and retention of learned information. 

The five steps listed on the following pages will help you navigate through the SQ3R strategies. 
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Step 1 S: Survey 

SQ3R 
Strategies 

Kurzweil 3000 
Tools to support strategies 

What to use… 

Preview the entire text 
Selection. 

Look at the general 
structure of the text: 

• Title 
• Introductory 

Paragraphs 
• Headings 
• Subheadings 
• Concluding 

Paragraphs 
• Charts 
• Graphs 
• Pictures 
• Captions 
• Key 

Vocabulary 
• Review 

Questions 

This provides the big 
picture or gist of the 
text, providing 
opportunities to think 
about what the text is 
about before beginning 
a thorough reading. 

 Text to speech technology to 
correctly read text selections 
aloud, model fluent reading, and 
support difficulties with decoding. 

o Adjustable Reading Speed 
o Choice of Reading Voices 

 Word Study tools available to 
ensure understanding of new 
vocabulary words and support 
reading comprehension. 

o Dictionary 
o Thesaurus 
o Picture Dictionary 

 Highlighters or Circle Tools for 
highlighting/circling key text 
structures before thoroughly 
reading the text. 

o Different colors of 
highlighters can be used 
to indicate specific text 
structures. 

 Read by Unit: 
o Headings 
o Highlight 

Main toolbar: Read button 

Reading Toolbar: 
Reading Speed and 
Reading Voice buttons 

Main toolbar: Dictionary 
(Adult, Children’s, Foreign 
Language and Picture) and 
Synonym buttons, which are 
part of the Word Attack tools. 
(Picture Dictionary also 
available.) 

Study skills toolbar: 
Highlighter (teacher-selected 
color code) and Circle 

Reading Toolbar: 
Reading Unit button 
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Step 2 Q: Question 

SQ3R 
Strategies 

Kurzweil 3000 
Tools to support strategies 

What to use… 

Turn each heading into 
a question. 

• Who 
• What 
• Why 
• When 
• How 
• Where 
• List… 
• Name… 

This gives you a 
reason to focus your 
attention on the text 
when reading it by 
looking for answers to 
your self-generated 
questions. 

Begin to guess what 
the answers might be 
and make predictions. 

Do NOT create 
“yes/no” questions. 
Create open-ended 
questions that 
encourage you to 
really think about the 
topic. 

 Sticky Notes can be used to insert 
questions/notes about the text. 
They are brightly colored and 
standout when reading the text. 

OR 

To support students by modeling the 
strategy: 
 Bubble Notes can be pre-inserted 

by a teacher. They are used to 
embed comprehension questions, 
clarify information, etc. Answers 
can be written, saved, and 
extracted for teacher or student 
use with Extract Annotations. 

 Writing Tools can be used to 
support the writing of test 
questions in Sticky Notes: 

o Speak as Typing 
o Speaking Spell Check 
o Word Prediction 

Note: 
 Extract Annotations feature can 

be used to extract any/all of your 
notes and highlights and create a 
new text document that can be 
used later to record answers or 
study for tests. 

Study skills toolbar: 
Sticky Note 

Study skills toolbar: 
Bubble Note 

Write toolbar: 
Spell check and 
Word prediction buttons 

   

Study skills toolbar 
Or File Menu 
Extract Annotations 

• Tile Vertically feature can be 
used to look at the textbook and 
your Sticky Note questions side- 
by-side. Later, answers to 
questions can be typed or 
dragged-and-dropped into the 
question document. 

Tile Vertically 
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Step 3 R: Read 

SQ3R 
Strategies 

Kurzweil 3000 
Tools to support strategies 

What to use… 

Read the entire text 
one section at a time. 

Focus on finding 
answers to the 
Questions you 
developed. 

Note important details 
and relationships as 
you read. 

Revise questions or 
add new questions 
based on your reading. 

• Text to speech technology to 
correctly read text selections 
aloud, model fluent reading, and 
support difficulties with decoding 

• Word Study tools available to 
ensure understanding of new 
vocabulary words and support 
reading comprehension. 

• Dictionary 
• Thesaurus 
• Picture Dictionary 

Main toolbar: Read button 

Main toolbar: Dictionary 
(Adult, Children’s, Foreign 
Language and Picture) and 
Synonym buttons, which are 
part of the Word Attack tools. 
(Picture Dictionary also 
available.) 

 Highlighters or Circle Tools for 
indicating key ideas, supporting 
details, answers to questions. Be 
sure to read the entire section of 
text first, then go back and make 
informed decisions about what to 
highlight or circle. 
o Different colors of 

highlighters/circles can be 
used to indicate specific 
categories of text selection. 
(e.g. Green-Topic and 
concluding sentences, 
Yellow=Key Ideas, 
Pink=examples, evidence and 
elaborations, Blue=new 
vocabulary) 

Study skills toolbar: 
Highlighter (teacher-selected 
color code) and Circle 

• Writing Tools can be used to 
support the writing of test 
questions in Sticky Notes: 

• Speak as Typing 
• Speaking Spell Check 
• Word Prediction 

Write toolbar: 
Spell check and Word 
prediction buttons 
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Step 4 R2: Recite 

SQ3R 
Strategies 

Kurzweil 3000 
Tools to support strategies 

What to use… 

Answer questions. 

Cover your reading 
text and just focus on 
answering your 
questions – state 
answers from memory. 

• Writing Tools can be used to 
support the writing of answers to 
test questions in Foot Notes: 

• Speak as Typing 
• Speaking Spell Check 
• Word Prediction 

Write toolbar: 
Spell check and Word 
prediction buttons 

   

Reread any 
information related to 
questions you can’t 
answer. 

Summarize 
Information. 

 Footnote tool for writing answers 
to your self-generated questions. 
The content of Footnotes is 
hidden until the footnote is 
opened. Footnotes appear as 
numbered boxes within the text. 

OR 

Study skills toolbar: 
Footnote button 

• Voice note tool can be used to 
insert a recording of your own 
voice reciting answers to your 
questions. 

Study skills toolbar: Voice 
button 

Note: Microphone is needed to 
record voice notes. 

OR 

• Extract Annotations feature can 
be used to extract the sticky notes 
and put them into a new 
document. This document can be 
printed. 

Study skills toolbar 
Or File Menu 
Extract Annotations 

• Tile Vertically feature can be 
used to look at the textbook and 
your Sticky Note questions side- 
by-side. Later, answers to 
questions can be typed or 
dragged-and-dropped into the 
question document. 

Window ->Tile Vertically 
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Step 5 R3: Review 
SQ3R 

Strategies 
Kurzweil 3000 

Tools to support strategies 
What to do… 

Review/Study Notes 
for retention of 
information. 

Make sure you can 
answer all questions. 

Try to recall main 
points of the text. 

• Create a study guide using 
Extract Annotations feature. 
This allows you to extract the 
sticky notes and footnotes put 
them into a new document to be 
used later. 

OR 

Study skills toolbar 
or File Menu 
Extract Annotations: 

Look over highlighted 
headings and questions 
and see if you can 
remember the answers. 

 Create an outline by using 
Extract Annotations to extract 
highlighted notes with topics and 
supporting details. 

The more time you 
spend reviewing, the 
better able you will be 
to remember the 
information. 

Option: 
• Tile Vertically feature can be 

used to look at the textbook on 
one side and your extracted Study 
guide with Sticky Note Questions 
and Footnote Answers on the 
other side. This can be helpful for 
reviewing the text and notes. 

Window -> Tile Vertically 

• Re-Read any sections of text for 
further reinforcement. 

Main toolbar: Read button 

For detailed instructions on how to use any of the Kurzweil 3000 features 
mentioned above, please refer to the Kurzweil 3000 “Help Menu” or to your 
Kurzweil 3000 Foundations Participant Workbook. 

Note: Kurzweil 3000 can be used to read tests aloud to students when they are 
required to demonstrate their understanding of curriculum content. It is also a 
powerful word processor with tools to support students through all stages of the 
writing process so that they can successfully express their knowledge through 
writing. 
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Canvas and ReadSpeaker   
_____________________________________________________________________________ 

ReadSpeaker Is Free Text-to-Speech in Canvas and Is 

Available for All Canvas Users 

ReadSpeaker is a text-to-speech tool that is ideal for those who benefit from having 
on-screen text read to them.   

This tool can read content within Canvas as well as attached files and webpages 
that are tagged properly.   

ReadSpeaker even defines and translates words.   

Its other features include limiting how much text is visible at a time, enlarging text, 
adjusting the speaker rate, and manipulating text and highlight colors to make it 
easier to read and/or follow along. 

How to learn more: 

• Visit ReadSpeaker.com to learn how to use ReadSpeaker and change the 

settings to best meet your needs. 

• Watch the video in Canvas for an introduction to ReadSpeaker. 

• Learn about webReader Keyboard Accessibility. 

• Watch YouTube playlists. 

https://www.readspeaker.com/solutions/text-to-speech-online/readspeaker-webreader/
https://dmacc.instructure.com/courses/165/pages/readspeaker-text-to-speech?module_item_id=2308
https://www.readspeaker.com/wp-content/uploads/2023/05/ReadSpeaker-webReader-v3.6-Accessibility-Keys_03.pdf
https://www.youtube.com/playlist?list=PLVqWGX39IRjUAi7Ag2c1DIfi-UmNqepLm
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Read Aloud Options for Digital Textbooks and Materials 

• Kurzweil 3000 Read the Web Extension for Chrome and Firefox web browsers. (Available free to 
students who qualify through the DMACC DSO) 

o This option requires granted accommodations from the DMACC Disability Services Office, 
and a username and password from DMACC Textbook Services.   

o The extension is free and can be found in the App Store by searching “Kurzweil” or 
“k3000.” 

o Once the extension is added, Kurzweil can read unlocked, online exams, web pages, and 
other online materials. The voice and speed of the reader can be adjusted, as well as other 
options.   

o For more information contact DMACC Textbook Services at k3000a@dmacc.edu. 
• Kurzweil 3000 for Web Browsers   

(Available free to students who qualify through the DMACC DSO) 
o This option requires granted accommodations from the DMACC Disability Services Office, 

and a username and password from Textbook Services. 
o This option is used by going to the Kurzweil website at 

https://www.kurzweil3000.com/KLogin.php. 
o Students will be given a virtual library where their books and classroom materials can be 

saved and opened into the Kurzweil 3000 text-to-speech reading program.   
o Other materials saved on your computer can also be opened and read aloud. 
o The voice/speed of the reader can be adjusted, as well as other options. 
o This option can be used with any device with internet access. 
o For more information contact DMACC Textbook Services at k3000a@dmacc.edu. 

• Adobe Built-In Reader 
o The Adobe Built-In Reader can be used to read PDF files aloud. 
o To use the Adobe Reader, open adobe and navigate to the document page you want to 

have read aloud. From the top-left Menu, click View, Activate Read Aloud (or press 
Shift+Ctrl+Y). Then, click View again, and Read Out Loud. You can choose to have the 
whole document read aloud or just the page you're on. Select either Read to End of 
Document or Read This Page Only, respectively. Selecting the Read Mode option will close 
other Adobe options, so you only see the page you are wanting to read. 

o For more information on Adobe, look here: https://www.adobe.com/. 
• Word Built-In Reader 

o The Word Read Aloud feature can be used to read Word documents aloud. 
o Word Read Aloud is only available for Office 2019, Office 2021, and Microsoft 365. 
o To use the Word Read Aloud feature: Open a Word file. On the Review tab, select Read 

Aloud. A small control panel will pop up on the top right of the page. Select the center 
arrow to read/pause. Select settings to toggle between the male and female voice. 

o For more information look here: https://support.microsoft.com/en-us/office/listen-to-
your-word-documents-5a2de7f3-1ef4-4795-b24e-64fc2731b001. 

• **NVDA 
o NVDA is a free, open source, accessible screen reader for the blind and vision 

impaired. It was created by NV Access, a registered charity and software 
development company. The NVDA screen reader can be downloaded free of 
charge by anyone. You can find more information here: 
https://www.nvaccess.org/download/.  

mailto:k3000a@dmacc.edu
https://www.kurzweil3000.com/KLogin.php
mailto:k3000a@dmacc.edu
https://www.adobe.com/
https://support.microsoft.com/en-us/office/listen-to-your-word-documents-5a2de7f3-1ef4-4795-b24e-64fc2731b001
https://support.microsoft.com/en-us/office/listen-to-your-word-documents-5a2de7f3-1ef4-4795-b24e-64fc2731b001
https://www.nvaccess.org/download/
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• **Zoom Text Magnifier with Reader (Available for purchase) 
o ZoomText Magnifier/Reader is a fully integrated magnification and reading program 

tailored for low-vision users. The Magnifier/Reader enlarges and enhances everything on 
your computer screen, echoes your typing and essential program activity, and 
automatically reads documents, web pages, email. Zoom Text is created to be used with 
Windows. 

o More information can be found here: 
https://www.freedomscientific.com/products/software/zoomtext/. 

• **JAWS (Available for purchase) 
o JAWS (Job Access With Speech) is a paid reader for Windows. It was developed for 

computer users whose vision loss prevents them from seeing screen content or navigating 
with a mouse. JAWS provides speech and Braille output for the most popular computer 
applications on your PC. 

o JAWS is offered by Freedom Scientific, Inc. More information can be found here: 
https://www.freedomscientific.com/products/software/jaws/. 

• **C-Pen (Available for purchase) 
o C-Pen is a state-of-the-art pen scanner designed to make it easier to process printed text. 

When the C-Pen is moved along a text line, the printed text is made digital. The digital text 
can then be read aloud by text-to-speech software, or it can be pasted into a document on 
a computer or smartphone. More information can be found here: https://cpen.com/. 

• E-Books with Built in Reader 
o E-books can be purchased through many online outlets, including the DMACC Bookstore. 

Many E-books come with their own built-in reader. Those that don’t, can usually be read 
by the Kurzweil 3000 web browser or web extension. Contact the DMACC Textbook 
Services Department for more help with this: k3000a@dmacc.edu. 

• Speechify 
o Turn anything on your laptop, desktop, and phone screen into audio. 
o Listen to emails, papers, and more. 
o Speechify works with Chrome, iOS, Android, Mac, & Edge. 
o There is a free limited option, and a paid premium option. 
o For more information, look here: https://speechify.com/. 

• Bookshare 
o Bookshare offers a library of over a million audiobooks and e-books. It also offers their 

Bookshare Reader as a free app. 
o U.S. students with qualifying disabilities can join for free. The DMACC Textbook Services 

Office can also get free books for students if they have qualified and been approved by the 
DMACC Disability Services Office. 

o More information can be found here: https://www.bookshare.org/. 
• Vital Source 

o The Vital Source Bookshelf offers many e-textbooks with a built-in read aloud text-to-
speech tool. These e-textbooks are available for purchase. 

o More information can be found here: https://www.vitalsource.com/bookshelf-features. 

** Good Options for students who are visually impaired. 
Updated June 2024 

https://www.freedomscientific.com/products/software/zoomtext/
https://www.freedomscientific.com/products/software/jaws/
https://cpen.com/
mailto:k3000a@dmacc.edu
https://speechify.com/
https://www.bookshare.org/
https://www.vitalsource.com/bookshelf-features
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OTHER RESOURCES 
Kurzweil 3000 Tech Support: Kurzweil 3000 Tech Support can help with any 
technical issues you are having with Kurzweil 3000 or questions you have about how to 
use the program when our office is unavailable. You can contact them at 1-800-984-
5374 or at tech@kurzweiledu.com. 

DMACC Tech Support: DMACC tech support can help with DMACC related 
technical issues and questions, such as questions regarding MyLab, computer labs, and 
login help. You can contact them at 515-965-7300 or 1-800- 362-2127 ext. 7300. 

DMACC Bookstores: DMACC Bookstores offer e-books for purchase or rent 
when available. Contact your campus bookstore for more information. 

DMACC Libraries: The DMACC Libraries provide a wide variety of print and 
non-print media including online resources such as electronic books, audio books, and 
online reference and research assistance. You can search their online database on the 
DMACC website, or you can contact them at 515-964-6317 or 1800-362-2127 ext. 6317. 

Project Gutenberg: Project Gutenberg is a library of over 70,000 free e- books. 
You can choose among free e-pub and Kindle e-books, download them or read them 
online. The focus here is on older works for which U.S. copyright has expired. No 
special apps are required to read these books. You can find Project Gutenberg at 
gutenberg.org. 

mailto:tech@kurzweiledu.com
https://gutenberg.org
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COPYRIGHT INFORMATION 

Please remember, the alternate textbook formats that 
DMACC and/or the textbook publishers provide to you are for 
you alone. They are not for you to share with others as to do 
so violates copyright laws. 
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KURZWEIL 3000 SYSTEM 
REQUIREMENTS 

For WINDOWS   

General Requirements 

PROCESSOR:    1.3 GHz Pentium 4 or better 

SYSTEM MEMORY:   2 GB 

HARD DISK SPACE:   2 GB of free space 

OPERATING SYSTEM:   Windows 11, 10 

ADDITIONAL Requirements: 

• Keyboard, mouse, Speakers or headset 

• Microphone (optional) 

• If scanning: TWAIN-compatible scanner   

• Latest version of Chrome, Firefox, or Edge for Read the Web functionality 

• Internet connection required for some features (Online Activation, Google 
Translate, Online Book Search, Read the Web, etc.)   

Specific Requirements for Network (Engine and Administration) 

• USB 2.0 port 
• Windows-compatible LAN running the TCP/IP protocol 
• Static IP address for the Network Engine host 

Specific Requirements for Web License 

Internet Connection: Minimum bandwidth of 512 kbps for each active Kurzweil 
3000 session. 
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KURZWEIL 3000 SYSTEM 
REQUIREMENTS 

For MAC 

All Clients: 

Processor:    Intel or Apple Silicon processor 
System Memory:   4 GB 
Hard Disk Space:   2 GB of free space 
Operating System:   Mac OS 10.13 through 13x 
Additional Requirements:   

• Keyboard, mouse, speakers, microphone 

• Image Capture-compatible scanner 

• Internet connection required for some features   
(Google Translate, Online Book Search, Read the Web, etc.) 

Additional Requirements for Web License:   

• Internet Connection required for product use. 

• All installed clients use some amount of bandwidth to connect to web services. 

• Although the clients will work at just about any speed, we recommend a minimum of 
56k/student, 512k/lab. 

Kurzweil 3000 does not currently support thin-client based environments as it was not designed 
for some of the special requirements of these systems. 
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SYSTEM REQUIREMENTS   
For KURZWEIL Web Browsers 

(kurzweil3000.com) 

General Requirements: 

Internet Browser (latest version recommended): 
• Chrome (minimum version 74) 
• Firefox (minimum version 72) 
• Safari (minimum version 12.0) 
• Microsoft Edge (minimum version 17) 
• Internet Explorer (minimum version 11) 

Cookies and JavaScript must be enabled.   
Minimum bandwidth of 512kbps for each active Kurzweil 3000 session. 
Network Connectivity Firewalls, proxy servers, and content filters must 
all permit access: HTTP (TCP port 80) HTTP and HTTPS (TCP port 
443). 

Speakers or earphones are recommended. 

https://kurzweil3000.com
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